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Introduction

 

Welcome to Boris GrafÞti 4.0. This document contain information regarding features that are 
new to this version of GrafÞti.

For information on installing Boris GrafÞti into your host application, see the 

 

Installation 
Guide.pdf

 

 Þle.

See the separate 

 

Release Notes.pdf 

 

document for information on supported hardware and 
operating systems, known limitations, and other important information about the product.

For information about Boris GrafÞti software updates, other Boris products, and additional 
resources, visit our web site at www.borisfx.com.

These new features may not included in the online User Guide.

 

What’s New in 4.0

 

Several new features and updates have been added to GrafÞti 4.0 including the following. 

 

New Spiral Blur Filter

 

GrafÞti 4.0 includes a new Color and Blurs Þlter. The BCC Spiral Blur Þlter creates a blur or 
smear that appears as though it is spiraling toward the center of the image. 

 

Original Image Filtered Image

 

New Distortion and Perspective Filters

 

GrafÞti 4.0 includes two new Distortion and Perspective Þlters.
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Displacement Map

 

The Displacement Map Þlter uses the luminance or color information from an alternate 
video or still image track (the Map Track) to displace the pixels in the source image 
horizontally and vertically. This Þlter creates a distorted version of the source whose 
distorted regions correspond to the luma or color channel of the Map Track�s media. 

 

Source image Map Track Filtered image

 

BCC Twirl 

 

The BCC Twirl Þlter spins the image around a center point, creating a spiral of distortion. 

 

Source image Filtered image

 

New Effects Filters

 

GrafÞti 4.0 includes two new Effects Þlters.

 

Burnt Film

 

Burnt Film simulates the look of holes burning through a layer of Þlm to reveal another 
image. This Þlter provides control over the appearance of the burned edges and the burn 
rate, and allows you to use a custom alpha matte to set the shape of the burn holes. 
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Burnt Film transition

 

Time 00:00:01:00 Time 00:00:02:00

 

BCC Emboss

 

BCC Emboss simulates the appearance of an embossed or raised image by converting the 
source to a solid color and lighting the edges in the source�s luma channel. 

 

Source image Filtered image
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New Light Zoom Filters

 

GrafÞti 4.0 includes a new Lights Þlter. The BCC Light Zoom Þlter creates rays of light that 
spread out from the light source point in all directions. As the rays expand, their intensities 
are affected by the luminosities of the pixels that they cross. The farther from the source the 
ray extends, the less it is affected by the intensities of new pixels that it crosses. This process 
is referred to as attenuation, since the affect of the pixels on the intensity of the rays 
attenuates, or lessens, over time.

 

Unfiltered Image Filtered Image

 

New Generators Filters available on the Boris website

 

Registered customers can download three new Generators Þlters from the Boris website.

 

BCC Fire

 

Fire is an auto-animated procedural Þre effect which offers control over ßame width and 
height, color, and movement, and allows you to generate smoke. This Þlter includes a Map 
Layer, allowing you to create Þre effects which conform to a pre-composed image or logo. 
If no track is selected, a separate Fire track is created.

 

Source image Filtered image
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BCC Rain

 

Rain is an auto-animated Þlter which generates realistic rain effects. The Þlter allows you to 
determine the density, speed, direction, and color of the drops, and to control the apparent 
depth of the effect. If no track is selected, a separate Rain track is created
.

 

Source image Filtered image

 

BCC Snow

 

Snow is an auto-animated snow generator which can composite snow over a sky color or an 
image. The Þlter offers extensive options for customizing the effect and allows you to create 
drifts or make ßakes pile up along the edges in an alpha channel. If no track is selected, a 
separate Snow track is created.

 

Source image Filtered image

 

New Chart Containers

 

GrafÞti 4 introduces the ability to create 3D charts in GrafÞti. The 3D Chart Container allows 
you to import tab or comma delimited data to create a chart using Spline Primitive shapes. 
You can export this format from any database or spreadsheet program. Instead of importing 
chart data, you can also enter chart data information manually into the Chart Editor. You 
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can create four different types of charts, a bar graph, a pie chart, a line graph or an area chart. 
Charts are animatable, using the parameters in the Animation tab. Charts can be either two 
dimensional or three dimensional. 

For detailed information on creating and using Chart Containers, see Chapter 8 in 
the User Guide.

 

Bar Graph  Pie Chart

Line Graph Area Chart

 

Localization

 

GrafÞti is now localized in several languages � English, French, German, Spanish, Italian, 
Japanese, Chinese and Korean. GrafÞti installs a Boris Language Pack Þle which reads the 
system language speciÞed on your system and translates its menus into that language, if it 
is supported. Localization should be automatic and requires no work on the part of users. 

The Boris Language Pack Þle is located in the following location.

 

Macintosh

 

Library/Application Support/BorisFX/Boris Language Pack.ecs

 

Windows

 

<Drive>\Program Files\Boris FX, Inc.\Boris Language Pack.ecs

 

You can edit the Boris Language Pack Þles with the Boris Localizer standalone 
application. See the next section for details.
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Editing Language Pack Files with the New Boris Localizer

 

GrafÞti 4.0 introduces the Boris Localizer. The Boris Localizer is a standalone 
Mac OS X application used to update the translation or localization of the GrafÞti interface 
into one of eight supported languages. Use the Boris Localizer to edit Boris Language Pack 
Þles which contain translations of GrafÞti menus and parameters into various languages. 
The Boris Localizer is available through your reseller.

Contact your reseller for more information on using the Boris Localizer to edit the 
default GrafÞti translations.

 

System Requirements

 

The Boris Localizer is a Macintosh application which requires Macintosh OS 10.3.x.

 

Note for Windows users:

 

 The Language Pack Þle can be edited on a Macintosh 
system using the Localizer. Then you can copy the Þle onto a Windows system. 
Place the edited Language Pack.ecs Þle in 

 

<Drive>\Program Files\Boris FX, 
Inc.\Boris Language Pack.ecs 

 

to rewrite the older Language Pack.ecs Þle. 

 

Supported Languages

 

GrafÞti supports localization into the following eight languages; 

 

English, French, German, 
Spanish, Italian, Japanese, Chinese 

 

and

 

 Korean

 

.

 

Understanding the Localizer

 

GrafÞti 4.0 uses a dictionary Þle called 

 

Boris Language Pack.ecs 

 

when translating its menus 
and Þlter parameters into various languages. This Þle is installed in the following location 
when you perform a full install of GrafÞti 4.0 on a Macintosh system.

 

/Library/Application Support/BorisFX/Boris Language Pack.ecs

 

The Boris Localizer allows you to edit the Language Pack Þle in signiÞcant ways: 

 

•   

 

Adding better translations for a particular language,

 

•   

 

Adding and removing strings, 

 

•   

 

Filtering its contents to show any missing translations, 

 

•   

 

Searching for strings that match a particular word or phrase.

Double-click to edit 
the translation
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New Library Browser Template Mode

 

You can use the Library Browser in a special Template mode. Template mode allows you to 
create effects directly in the Library Browser. This mode is useful for creating text effects or 
transitions. For example, if you apply a transition preset, the placeholder images are 
replaced with your timeline video tracks. When you are in this mode, you can also replace 
the text for the selected effect template.

When you work in Template mode, the Library Browser is the only window that appears in 
the Boris GrafÞti user interface. This feature is only available when you use Boris GrafÞti as 
a plug in. It is not available in the standalone KeyFramer application.

 

1.

 

Click the yellow 

 

Template Mode

 

 

 

button

 

 to toggle into template mode. When 
you are not in Template Mode, this is the only control that appears in the 
Library Browser window. 

The illustrations below are taken from Boris Red. However the Library Browser 
works the same way in Boris GrafÞti as it does in Boris Red.

 

2.

 

Click the name of any folder in the Available Categories window. Thumbnail images of 
each effect in that folder appear in the Available Effects window.

 

3.

 

Click any thumbnail image to select the effect. A red box appears around the selected 
thumbnail. Press 

 

Play

 

 to view an animated RAM preview in the Preview window. 

Selected effect.

Available Categories
window. Click a folder
name to preview the
effects in that folder.

Animated preview of
selected effect

Link to Boris 
FX website.

Effect comments

Quality, Preview, and
Effect buttons

Source Folder menu

Template-Mode
controls
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4.

 

Click the appropriate Template-Mode control to edit your template.

 

•

 

The yellow 

 

Template Mode

 

 

 

button

 

 toggles in and out of template mode. When you 
are not in Template Mode, this is the only control that appears in the Library 
Browser window. 

 

•

 

The red 

 

Insert Text button

 

 allows you to type text into the Comments window to 
replaces the placeholder text that is included in the thumbnail. To replace multiple 
lines of text, press 

 

Tab

 

 between each line. 

 

•

 

The green 

 

Replace Comments button

 

 allows you to type comments into the 
Comments window. This text replaces the existing comments. 

 

•

 

The blue 

 

Retrieve Comments button

 

 allows you to retrieve comments. Click this 
button if you have inserted text into the Comments window and now want to view 
the associated comments. 

 

5.

 

Click the 

 

Apply button 

 

to apply the effect, close GrafÞti and return to your host.

In the following example, the text from the 

 

JitterHue.red

 

 setting in the previous 
example was replaced with the words 

 

Anne�s Jitter

 

. To replace the text, the effect was 
selected, the 

 

red Insert Text button

 

 was clicked and the new text was entered into the 
Comments window.

Retrieve Comments

Template Mode Replace Comments

Insert Text 

Selected effect
Preview of selected

effect

New Text

Template-Mode
controls
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New Preferences

 

A new Appearance tab has been added to the Preferences window. The Appearance tab lets 
you set display options for the Boris GrafÞti user interface. 

You can access the Preferences window by choosing Edit > Preferences (Windows) or Boris 
GrafÞti > Preferences (Macintosh).

 

Appearance Tab

Common Background Colors

 

These options allow you to customize the colors used in the Boris GrafÞti user interface. 
This is a new feature in Boris GrafÞti 4.0

Click the color chip to open the system color picker and choose the desired color.

 

Windows

 

 

 

sets the color of the background for all windows in the Boris GrafÞti user interface.

 

Text

 

 

 

sets the color of the text in all windows in the Boris GrafÞti user interface.

 

Timeline Colors Options

 

These options allow you to customize the colors used in the Boris timeline tracks. In 
previous versions of Boris GrafÞti, these options appear in the Preview tab. 

Click the color chip to open the system color picker and choose the desired color.

 

Background

 

 

 

sets the color of the timeline background.

 

Selection

 

 sets the color of selected tracks in the timeline�s track controls (the left side of the 
timeline).
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Keyframe

 

 sets the color of keyframes.

 

Shape Track

 

 

 

sets the color of Shape tracks on the right side of the timeline.

 

Media Track

 

 

 

sets the color of the Media tracks nested inside Shape tracks.

 

Container Track

 

 sets the color of 3D Containers and Title Containers.

 

Filter Track

 

 

 

sets the color of Þlter tracks on the right side of the timeline.

 

Library Browser

 

When you select the 

 

Show Only Browser checkbox

 

, only the Library Browser appears when 
you work in the Boris GrafÞti user interface. For more information on this new features, see 
�New Library Browser Template Mode� on page 9.

 

New Presets

 

Boris GrafÞti version 4.0 includes a collection of100 new presets.

 

Graffiti Plug-Ins and Library Browser Now Accept Aliases

 

The GrafÞti Plug-Ins folder and Library Browser now accept aliases to plug-in and effect 
Þles and folders on your system and will follow them to the original Þle or folder.

 

Aliases in the Library Browser

 

If you place an effect alias or shortcut to a folder or Þle in the Library Browser, GrafÞti will 
now follow it to another folder or Þle, as if that folder were where the alias or shortcut is 
placed.

 

Aliases in the Plug-Ins folder 

 

If you place an alias or shortcut to a folder or Þle in the GrafÞti Plug-Ins folder, GrafÞti will 
now follow it to another folder or Þle, as if that folder were where the alias or shortcut is 
placed. 

The Boris GrafÞti Plug-Ins folder is found in the following location:

 

Macintosh

 

<Drive>:Library:Application Support:BorisFX:BorisPlugins

 

Windows

 

c:\Program Files\Boris FX,Inc\BorisPlugins\
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This means that you no longer need to make copies of your plug-ins, since you can now 
keep centrally located plug-in set(s). For instance, if you already have a copy of BCC 3 (Boris 
Continuum Complete 3) in 

 

Application Support:BorisFX:Lib:BCC3BitDepthSupport

 

, you 
only need place an alias/shortcut to that folder inside the BorisPlugins folder. 

GrafÞti currently only supports 8-bit plug-ins. Placing an alias or shortcut to 16-bit 
plug-ins in the Boris Plugins folder will cause undesirable results.

 

Improved Support for Third Party After Effects Plug-Ins

 

GrafÞti 4.0 expands support for third Party After Effect plug-ins inside Incite. For best 
results, use only supported AE Þlters inside Boris GrafÞti. Current additions to this list can 
be found on our web site: www.borisfx.com. 

For information on installing and using third Party Plug-Ins, see the Release Notes.

Most of the unsupported Þlters will not appear in the GrafÞti Filter menu even if 
they are installed, or will display an error message when you apply them.

 

Buena Software

 

•   

 

Dissolve Factory

 

•   

 

Effect Essentials*

 

*Note: 

 

The following Buena Effect Essentials Þlters are not supported: 

 

Feedback, 
HSV Curves, HSV MAnipulator, Super RGB Curves

 

.

 

Conoa

 

•   

 

Conoa 3Dr

 

•   

 

Easy Shapes

 

•   

 

SuperPak

 

*Note: 

 

You must use the AE 4.0 versions of Conoa Þlters with Boris GrafÞti. Later 
versions will not work.

 

Cycore

•   Cycore FX HD*

*Note: The following Cycore FX HD Þlters are not supported: all Time Filters, 
Composite, Environment, Split 2, Repetile.
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DigiEffects

•   Aurorix

•   Beserk

•   Cinemotion*

•   Delerium**

•   Fantasm***

*Note: Cinemotion Film Motion effects do not work in GrafÞti.

**Note: The following DigiEffects Delerium Þlters are not supported: Channel 
Delay, Fireworks, Fairy Dust, Film Flash, Muzzle Flash.

***Note: The following DigiEffects Fantasm Þlters are not supported: Color by 
Number, Shredder, PixxyUnstripe, PixxyAudio.

Digital Anarchy

•   3D Layer

•   Color Theory

•   Geomancy

•   Gradient

•   Psunami Water

•   Retimer SD and HD

•   Anarchy Toolbox*

*Note: The following Anarchy Toolbox Þlters are not supported: Anarchist Edge, 
Color Sampler, Gradient Path, Path Distort, Resizer.

Digital Film Tools

•   Digital Film Lab

•   zMatte

•   Composite Suite*

•   55 mm**

*Note: The Frame Averager Composite Suite Þlter is not supported.

**Note: GrafÞti supports version 55 mm version 2.0 only. Versions 3.0 and 4.0 are 
not supported.
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The Foundry

•   KeyLight

•   TinderBox 1, 2, 3*

*Note: The following Tinderbox Þlters are not supported: T_PseudoColour, 
T_Blob, T_Grad, T_Sky, T_Plasma, T_Glow, T-MeltTime, T_Trail, 
T_MotionDetect.

FreshLuft

•   ßAIR

Panopticum

•   Camera Noise

•   Compare Mask

•   Engraver

•   Rulers

•   Plugin Galaxy

Profound Effects

•   Swim

Red Giant Software

•   Knoll Light Factory

•   Image Lizard and Composite Wizard*

*Note: The following Image Lounge and Composite Wizard Þlters are not 
supported: Video Feedback, Wire&RigRemoval, Denoiser, Hall of Time, Color 
Map, Color Matcher, Brimstone, Clouds, Fire, Tunnel, Text.

Re: Vision Effects

•   Fields Kit

•   Re:Fill

•   ReelSmart Motion Blur

•   Shape/Shade

•   SmoothKit

•   Twixtor Pro

•   Video Gogh



16   

• 
• 
• 
•
•
•

Synthetic Aperture

•   Color Finesse

Trapcode

•   Shine

•   Star Glow

Walker Effects

•   Professional Edition*

*Note: The following Walker Effects Þlters are not supported: Alpha Tool, Channel 
Offset, Color Composite, Fast Tracker, Glow, Light Wrap.

New Host and Hardware Specific Features
The following new host or hardware related features have been added to GrafÞti 4.0.

New Supported Hardware
GrafÞti 4.0 introduces hardware improvements including the following:

•   The Aja IO board now works with Aja driver version 1.3 and higher. Previously you 
would crash opening the GrafÞti Preferences with this board and a driver version 
earlier than 1.3.

•   The Aja Kona II and IO boards installed with the latest drivers (1.3 and higher) now 
allow you to preview out to an external monitor.

GrafÞti only supports Aja drivers with the Aja board.

Support for Canopus Edius Pro 3
GrafÞti 4.0 now supports the Canopus Edius Pro 3 editing workstation. 

For details on applying GrafÞti in Edius and Edius Pro, see Appendix B in the User 
Guide.
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Preview to Monitor Feature for Avid Systems
Preview to Monitor is now available when using GrafÞti as an Avid plug-in on systems 
running Mojo or Adrenaline hardware using Xpress Pro version 4.5 and later, or Media 
Composer Adrenaline version 1.5. Additionally, beginning with GrafÞti 4.0, Preview to 
Monitor is available to Windows users using the standalone GrafÞti KeyFramer on systems 
running the Mojo or Adrenaline hardware.

For more information on the Preview to Monitor feature, see the User Guide.

Enabling Preview to Monitor

To enable the Preview to Monitor feature, launch the GrafÞti KeyFramer and open the 
Preferences window.

1. Choose File > Preferences.

2. Click to select the Preview tab.

3. In the External Monitor Output section, 
choose Avid Hardware from the Device 
menu. 

The Device menu displays all the 
supported hardware connected to your 
system.

4. Choose an option from the Mode menu if 
applicable. For example, if you are using a FireWire Converter box, you can choose PAL 
and NTSC formats from the Mode menu.

5. Click OK to save your settings and exit the Preferences window.

The Preview to Monitor preferences are saved and applied to all GrafÞti projects 
unless your GrafÞti 4.0 preference Þle is rebuilt.

Displaying Frames in your External Monitor

Commands in the Preview menu allow you to set the video display: 

•   When Connect to External Monitor is chosen in the Preview menu, Preview to Monitor 
is enabled and the following three options in the menu become available:

Choose Avid Hardware from the Device menu.

Choose Connect to External Monitor 
to display images on the external 
monitor
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•   When you choose Auto-Update Monitor from the Preview menu, every frame of your 
effect previews to the external video monitor. This allows you to drag the CTI in the 
timeline and view updating frames. The image displays on the external monitor, using 
the Resolution and Quality settings speciÞed in the Composite window.

Enabling Auto-Update Monitor will slow the GrafÞti KeyFramer since every frame 
is updated in the external monitor.

•   When you choose Display Frame on Monitor from the Preview menu or click the 
Display Frame to Monitor button in the upper-right corner of the Composite 
window, the current frame displays on the external monitor, using the Resolution 
and Quality settings speciÞed in the Composite window. 

•   When you choose Display HQ Frame to Monitor from the Preview menu, the image 
displays on the external monitor, using Full Resolution and High Quality settings, 
regardless of the Resolution and Quality settings in the Composite window. 

Disconnecting Preview to Monitor

To disconnect Preview to Monitor (for example if you want to connect another device to 
your video board while editing with Boris GrafÞti), quit GrafÞti. When you relaunch GrafÞti 
the external monitor is not connected until you choose Connect to External Monitor in the 
Preview menu.

Improved Support for Sony Digital Pictures Vegas Video
Boris GrafÞti supports Sony Digital Pictures Vegas � version 4.0 and later. In GrafÞti 
version 4.0, the integration with Vegas has been improved with optimizations, bug Þxes and 
the addition of several default presets. 

By default, Vegas caches every video frame. This results in effects not displaying 
correctly after re-editing. To disable the Vegas cache, open the Vegas Preferences 
from the Options menu. Click the Video tab and set Dynamic RAM Preview max 
(MB) to 0. 

Improvements to Vegas in Graffiti 4.0

•   Mini-timeline removed- The mini-timeline in the Vegas dialog has been removed. 
There were underlying problems with this mini-timeline that could cause GrafÞti to 
crash.

•   Modal window- GrafÞti is now a modal window which improves performance inside 
Vegas. This means that when you launch GrafÞti, you can no longer toggle back to 
Vegas with GrafÞti open. You must apply or cancel out of GrafÞti in order to use Vegas 
again.

•   Faster Rendering of Static Effects- GrafÞti 4.0 is optimized so that static effects (effects 
that are not keyframed in the GrafÞti timeline) render much faster then in GrafÞti 3.0. 
Rendering speed increases depend on the complexity of the effect.
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•   New Default Presets- GrafÞti 4.0 includes several new Vegas Video preset Þles. These 
presets can apply to GrafÞti in any context in Vegas Video 5. You can modify these 
effects and save variations as your own custom presets. One new preset, the Alpha 
Default preset provides a way to make GrafÞti titles and effects that cut an alpha 
channel look sharp. XXXDIRK????

•   Fixed Bugs- Animations longer than one second no longer render twice as fast when 
rendered at Full Quality in interlaced video projects.

Applying Boris Graffiti as a Video Effect

Boris GrafÞti appears in the list of available video effects in the Video FX window and can 
be applied as a video effect the same way you apply any native video effects in Vegas.

The GrafÞti timeline will not display updated video frames while launched inside 
Vegas. Only the video frame at the cursor location displays in GrafÞti�s timeline. 
This limitation of Vegas�s architecture does not impact rendering effects.

1. Drag the Boris GrafÞti video effect from the Video FX window to an event or track. The 
Event Effects window opens.

2. Move the Vegas cursor to the Þrst frame of the effect to display the Þrst frame in GrafÞti. 
Otherwise the frame at the Vegas cursor location displays in GrafÞti.

3. Click the Launch Boris FX Button to open the GrafÞti interface and create your effect.

4. In the GrafÞti Timeline window, set the effect duration to 
match the duration of your Vegas effect by typing a new value 
in the Duration Þeld and pressing Enter.

If the GrafÞti effect duration does not match the Vegas 
effect duration, the rendered effect in Vegas appears 
differently than when you preview it in GrafÞti.

5. Choose Edit > Preferences to open the Preferences window. In the General tab in the 
Preferences window, set the Project Options to match the project size, FPS and aspect 
ratio that you are using in Vegas. Click OK to close the Preferences window.

6. You can now open settings from the Keyframe Library or create your own custom 
effect. When you Þnish creating your effect, press the Apply button to apply the effect 
to Vegas.

Tips for using Boris Graffiti with Sony Digital Pictures Vegas
•   The frame that Vegas Video passes to GrafÞti does not necessarily match the Vegas 

project size. Instead this frame is the same size as the frame displayed in the Vegas 
Preview window. Any Preview window setting will work, but best results are achieved 
by setting the Preview window to Best/Full before launching Boris GrafÞti.

Set the Red duration to 
match the Vegas duration.
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• 
• 
• 
•
•
•

•   Vegas only previews a single frame of video in Boris GrafÞti. The preview frame is 
taken from the current position of the Vegas cursor. To preview your effect with 
updating source media, exit GrafÞti and preview the effect in the Vegas Video timeline. 

•   To preview a GrafÞti effect in Vegas, you must Þrst click the Apply button. You cannot 
preview changes in Vegas while the Boris GrafÞti user interface is launched.

•   By default, Vegas caches every video frame. This results in effects not displaying 
correctly after re-editing. To disable the Vegas cache, open the Vegas Preferences from 
the Options menu. Click the Video tab and set Dynamic RAM Preview max (MB) to 0. 

For important workßow and notes for Vegas Users, see Appendix B in the User 
Guide �Working with Host Applications.

Improved Host Support for IMC Incite
GrafÞti 4.0 adds functionality to Incite Media and Remote Producer, and adds compatibility 
with the new Container feature in Media and Remote Producer version 3.3.

New Modal User Interface

Boris GrafÞti now works modally in Incite. This means that when the GrafÞti user interface 
is launched, you cannot toggle back to Incite. You need to apply or cancel out of GrafÞti in 
order to use Incite. This new model improves GrafÞti�s speed and stability.

Access to 64 Incite Video Tracks

You can now access up to 64 Incite video tracks within GrafÞti. To directly access an Incite 
video track within GrafÞti, press the Media icon on any track in the GrafÞti timeline. 
Choose the appropriate track from the menu that appears.

OpenGL Enabled in Final Cut Pro 4.1
OpenGL is now fully enabled for FCP 4.1 when you run Macintosh OSX 10.3. Previously 
OpenGL was not available in this version of Final Cut Pro with earlier versions of the 
Macintosh OS.

New Quit and Save As Behavior
When you quit GrafÞti, the name of the saved setting is displayed and saved when you 
press OK. The application then quits, which eliminates the extra dialog box that you 
previously had to dismiss.

If you want to save the open setting with another name, you can press Cancel and then save 
your setting. If the setting has not been saved previously, the dialog prompts you to save it.
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New Preview to RAM Behavior
When audio is disabled, Preview to RAM now loops the playable frames, rather than 
playing the frames then holding the last frame for the full (or in/out) duration. 
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